
With the SolidView® family of products, design communication has never been easier.  SolidView/Pro is a powerful,
yet extremely easy to use, Windows program designed to communicate 2D and 3D data from virtually any CAD
system.  With SolidView/Pro, anyone with a Windows PC can view, measure, and mark up CAD data.  Instead of
working with confusing paper drawings, you can now have a real-time shaded view of your CAD designs,
without the need for expensive CAD hardware or software, and without extensive training.

SolidView/Pro's measuring, 3D
dimensioning, and annotation features make
it easy to communicate design intent or to
highlight changes or errors.  With one mouse
click, you can instantly calculate the volume,
surface area, mass, and center of gravity of
complex designs and assemblies.  Note and
text features let you add detailed design
information, and an electronic grease pencil
lets you add red-line markups.  Integrated
2D viewing makes it possible to view
detailed manufacturing information along
with 3D shaded images.

With SolidView/Pro's exclusive publishing
capability, you can even send a FREE 2D/

3D viewer with your designs.  This viewer, called SolidView/Lite, lets the recipient view and optionally measure
your designs, without requiring them to purchase any software.  SolidView/Pro adds instant value to your existing
3D CAD data by allowing everyone involved in the product development process—engineering, manufacturing,
purchasing, Quality Assurance, suppliers, marketing and sales, and even customers—to share the design data on
their Windows PC.

❋❋❋❋❋ Real-time rendering on Windows 95, 98, and
NT, without hardware acceleration

❋❋❋❋❋ Exclusive SolidView/Lite publishing capability
❋❋❋❋❋ Optional interfaces for Pro/E*, CATIA, and

Unigraphics*
❋❋❋❋❋ Advanced OpenGL rendering
❋❋❋❋❋ Support for STL, SolidWorks, VRML, DWG,

DXF, and OBJ CAD files as well as other
popular 2D vector and raster formats

❋❋❋❋❋ Translate, scale, rotate, mirror, copy and
combine 3D data

❋❋❋❋❋ Easy to learn, intuitive user interface
❋❋❋❋❋ Flexible, multi-level security
❋❋❋❋❋ Assembly viewing tools
❋❋❋❋❋ 3D dimensioning of edges, faces, arcs, points,

objects, and assemblies
❋❋❋❋❋ Collaborative engineering review tools
❋❋❋❋❋ 2D and 3D Web publishing and viewing
❋❋❋❋❋ Cross-section display and measurements
❋❋❋❋❋ Options for IGES, VDA/FS, Rapid

Prototyping, and network licensing
❋❋❋❋❋ Complete, on-line, context sensitive help

SolidView/Pro FeaturesSolidView/Pro FeaturesSolidView/Pro FeaturesSolidView/Pro FeaturesSolidView/Pro Features

*Requires appropriate CAD system license
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With the SolidView® family of products, design communication has never been easier.  SolidView is a low-cost,
easy to use, program for viewing and measuring a variety of 3D CAD data formats.  SolidView/Lite is a FREE 3D
viewer designed to facilitate the exchange of 3D data in SolidView's Solid File eXchange (SFX) format.  With the
SolidView family of products, anyone with a Windows PC can view, measure, and mark up CAD data.  Instead of
working with confusing paper drawings, you can now have a real-time shaded view of your CAD designs,
without the need for expensive CAD hardware or software, and without extensive training.

SolidView and SolidView/Lite read STL,
SolidWorks, VRML, OBJ, and 3D Face data
in DXF format.  SolidView and SolidView/
Lite also read the SFX file format, and
SolidView provides the ability to add notes
and markups to an existing SFX file, enabiling
bi-directional 3D communication.
SolidView's measuring, 3D dimensioning, and
annotation features make it easy to
communicate design intent or to highlight
changes or errors.  With one mouse click, you
can instantly calculate the volume, surface
area, mass, and center of gravity of complex
designs and assemblies.  Note and text features
let you add detailed design information, and
an electronic grease pencil lets you add red-
line markups.

SolidView/Pro adds instant value to your existing 3D CAD data by allowing everyone involved in the product
development process—engineering, manufacturing, purchasing, Quality Assurance, suppliers, marketing and sales,
and even customers—to share the design data on their Windows PC.
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❋❋❋❋❋ Real-time rendering on Windows 95, 98, and
NT, without hardware acceleration

❋❋❋❋❋ Reads Solid File eXchange (SFX) files from
SolidView/Pro and SolidView

❋❋❋❋❋ 3D dimensioning of SFX data
❋❋❋❋❋ Advanced OpenGL rendering
❋❋❋❋❋ Support for STL, SolidWorks, VRML, DXF,

and OBJ CAD files

SolidView/Lite FeaturesSolidView/Lite FeaturesSolidView/Lite FeaturesSolidView/Lite FeaturesSolidView/Lite FeaturesSolidView FeaturesSolidView FeaturesSolidView FeaturesSolidView FeaturesSolidView Features

❋❋❋❋❋ Real-time rendering on Windows 95, 98, and
NT, without hardware acceleration

❋❋❋❋❋ 3D dimensioning of edges, faces, arcs, points,
objects, and assemblies

❋❋❋❋❋ Advanced OpenGL rendering
❋❋❋❋❋ Support for STL, SolidWorks, VRML, DXF,

and OBJ CAD files
❋❋❋❋❋ Reads and writes Solid File eXchange (SFX)

files from SolidView/Pro
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The SolidView® family of products supports a variety of 2D and 3D file formats.  New file types are being
developed continually.  For the latest information on supported file formats, please visit www.cadcommunications.com

3D Import Formats
Extension(s) Description Notes
.dxf 3D face data in AutoCAD DXF format
.obj Wavefront/Alias 3D format
.sfx SolidView Solid File eXchange format
.sldasm SolidWorks assembly file
.sldprt SolidWorks part file
.stl Ascii and binary stereolithograpy rapid prototyping data
.wrl VRML 1.0 and 2.0 formats 1
SolidView/Lite 3D Import Notes:
1. VRML 2.0 requires the free VRML 2.0 plugin available from www.cadcommunications.com

3D Import Formats
Extension(s) Description Notes
.dxf 3D face data in AutoCAD DXF format
.obj Wavefront/Alias 3D format
.sfx SolidView Solid File eXchange format
.sldasm SolidWorks assembly file
.sldprt SolidWorks part file
.stl Ascii and binary stereolithograpy rapid prototyping data
.wrl VRML 1.0 and 2.0 formats 1
SolidView 3D Import Notes:
1. VRML 2.0 requires the free VRML 2.0 plugin available from www.cadcommunications.com

ew
3D Export Formats

Extension(s) Description Notes
.sfx SolidView Solid File eXchange format 1
SolidView 3D Export Notes:
1. SolidView can edit and save an .sfx file, but new .sfx files cannot be created from other 3D data formats
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3D Import Formats
Extension(s) Description Notes
.dxf 3D face data in AutoCAD DXF format
.cat, .model, .exp Catia Export and model files produced by the Unix and mainframe versions of 1, 5

Catia.  Imports Faces, Solids (Exact and Mockup), Volumes, Skins,
Polyhedral Surfaces, and SKD elements.  Support for Ditto, Line, Curve,
Composite Curve, and Conic wireframe entities.  Supports all V4 versions.

.iges IGES surface and 3D curve data 2, 5

.obj Wavefront/Alias 3D format

.prt Pro/E part files (R18-2001).                          3, 5

.prt Unigraphics part and assembly files V16 and earlier.      4, 5

.sfx SolidView Solid File eXchange format

.sldasm SolidWorks assembly file

.sldprt SolidWorks part file

.stl Ascii and binary stereolithograpy rapid prototyping data

.vda VDA-FS (Verband Der Automobilindustrie Flachen Schnittstelle) files. 2, 5
German National Standard DIN 66301

.wrl VRML 1.0 and 2.0 formats
SolidView/Pro and SolidView/Pro RP 3D Import Notes:
1. Requires SolidView/Pro Catia Import Option.  No Catia license required.
2. Requires SolidView/Pro IGES-VDA Import Option.
3. Requires SolidView/Pro Pro/E Import Option.  No Pro/E license required.
4. Requires SolidView/Pro UG Import Option and access to UG Gateway license.
5. Imported files may not be suitable for rapid prototyping functions without the use of the SolidView/Pro RP
    Repair function.

3D Export Formats
Extension(s) Description Notes
.dxf 3D face data in AutoCAD DXF format
.iges Planar IGES surface data 1
.obj Wavefront/Alias 3D format
.sfx SolidView Solid File eXchange format
.stl Ascii and binary stereolithograpy rapid prototyping data
.sv SolidView 1.0 format
.wrl VRML 1.0 and 2.0 formats
SolidView/Pro and SolidView/Pro RP 3D Export Notes:
1. Requires SolidView/Pro IGES-VDA Import Option.

SupporSupporSupporSupporSupported 2D and 3D SolidVted 2D and 3D SolidVted 2D and 3D SolidVted 2D and 3D SolidVted 2D and 3D SolidView File Foriew File Foriew File Foriew File Foriew File Formats (continued)mats (continued)mats (continued)mats (continued)mats (continued)

SolidView/Pro and SolidView/Pro RP
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2D Import Formats
Extension(s) Description Notes
.bmp OS/2 or Windows bitmap
.cgm Computer Graphics metafile
.dxf Autodesk Drafting Interchange
.dwg Autocad drawing
.emf Enhanced Windows metafile
.gif CompuServe
.hpgl, hpgl2, .plt HP Graphics Language
.jpeg JPEG group
.pct Macintosh PICT
.pcx ZSoft Paintbrush
.png Portable Network Graphics
.ras Sun Microsystems
.tga Truevision (Targa)
.tiff Tagged Image File Format
.txt Text document
.wmf Windows metafile

2D Export Formats
Extension(s) Description Notes
.bmp OS/2 or Windows bitmap
.eps Encapsulated Postscript File
.gif CompuServe
.jpeg JPEG group
.pct Macintosh PICT
.pcx ZSoft Paintbrush
.png Portable Network Graphics
.ras Sun Microsystems
.tga Truevision (Targa)
.tiff Tagged Image File Format
.wmf Windows metafile

SupporSupporSupporSupporSupported 2D and 3D SolidVted 2D and 3D SolidVted 2D and 3D SolidVted 2D and 3D SolidVted 2D and 3D SolidView File Foriew File Foriew File Foriew File Foriew File Formats (continued)mats (continued)mats (continued)mats (continued)mats (continued)

SolidView/Pro and SolidView/Pro RP (continued)
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The SolidView® IGES/VDA import option will enable SolidView/Pro and SolidView/Pro RP to read IGES and
VDA data.  Once the 3D data has been read into SolidView, it can then be  measured, moved, scaled and analyzed.
If no trimmed surfaces are found, SolidView will read any 3D Curve entities and display them as wireframe data.
The following IGES entities are supported:

Entity # Name Type Notes
100 Circular Arc Curve

102 Composite Curve Curve

104 Conic Arc Curve

106 Copius Data Curve

108 Bounded Plane Surface Unbounded planes not supported

110 Line Curve

112 Parametric Spline Curve Supported (126 is preferred)

114 Parametric Surface Surface Supported (128 is preferred)

118 Ruled Surface Surface

120 Surface of Rev. Surface

122 Tabulated Cylinder Surface

124 Transform Matrix Matrix

126 Rat. B-Spline Curve Curve Preferred Trim Curve Entity Type

128 Rat. B-Spline Surface Surface Preferred Surface Entity Type

140 Offset Surface Surface

141 Boundary Entity Curve Supported in SolidView IGES 2.1 and later

142 Curve on Parm. Surface Curve

143 Bounded Surface Surface Supported in SolidView IGES 2.1 and later

144 Trimmed Parm. Surface Surface

186 Manifold Solid B-Rep Object Supported in SolidView IGES 3.2 and later

190 Plane Surface Surface Supported in SolidView IGES 3.2 and later

192 Circular Cylinder Surface Supported in SolidView IGES 3.2 and later

194 Circular Conic Surface Supported in SolidView IGES 3.2 and later

196 Spherical Surface Surface Supported in SolidView IGES 3.2 and later

198 Toroidal Surface Supported in SolidView IGES 3.2 and later

308 Subfigure Definition SubFig Supported in SolidView IGES 3.2 and later

406 Tabular Data Data Not currently supported

408 Subfigure Instance SubFig Supported in SolidView IGES 3.2 and later

416 External Reference SubFig Not currently supported, combine into single file

SolidView is a registered trademark of Solid Concepts Inc.
Other products are trademarks or registered trademarks of their respective holders.
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Note:  Optimum IGES translation results with trimmed NURB surfaces/curves IGES entities 128 and 126.  Converted IGES files
can be saved as SFX, STL, VRML, and 3D DXF for viewing in SolidView/Lite or SolidView.  STL files generated from IGES or
VDA data may not be suitable for rapid prototyping applications without the use of the SolidView/Pro RP  repair function.  Users
can obtain the latest IGES/VDA import DLL (libgeom.dll) from www.solidconcepts.com.
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SolidView/Pro RP combines the 3D communication features of the SolidView® family of products with an extensive
array of rapid prototyping functions.  SolidView/Pro RP makes it possible to quickly prepare multiple STL files
for rapid prototyping on any popular RP system.  SolidView/Pro RP includes advanced functions for repairing
STL files and for preparing stereolithography rapid prototypes.  With SolidView/Pro RP, you can quickly and

easily translate, scale and rotate STL files on your Windows PC, instead of
using an expensive CAD or RP system.  SolidView/Pro RP lets you copy and
combine STL files, or split STL files into multiple parts.  Drag and drop manual
part layout, combined with automatic layout and a build time estimator, make
it easy to maximize the throughput of any rapid prototyping system.

SolidView/Pro RP includes functions for automatically repairing common STL
file problems, including closing gaps, correcting normals and fixing vertix-to-
vertix problems.  SolidView/Pro RP Z-adjust and drain hole functions make it
possible to build faster and more accurate stereolithography rapid prototypes.
The optional Bridgeworks module enables SolidView/Pro RP users to create
stereolithography support structures on their Windows PC.

SolidView/RP Master FeaturesSolidView/RP Master FeaturesSolidView/RP Master FeaturesSolidView/RP Master FeaturesSolidView/RP Master Features

❋❋❋❋❋ All SolidView/Pro features, including view, measure, annotate and publish
❋❋❋❋❋ Drag and drop manual part layout
❋❋❋❋❋ Automatic part layout and build time estimator for all popular rapid prototyping systems
❋❋❋❋❋ Shell function for creating hollow parts from solid geometry
❋ ❋ ❋ ❋ ❋ Verify function to test STL file integrity
❋ ❋ ❋ ❋ ❋ Section STL files to create smaller buildable parts
❋ ❋ ❋ ❋ ❋ Automatic correction of common STL file problems such as small gaps, incorrect triangle normals,

and misaligned triangle vertices
❋❋❋❋❋ Shell function
❋❋❋❋❋ Drain hole and Z-adjust for more accurate stereolithography parts

SolidView/Pro RP FeaturesSolidView/Pro RP FeaturesSolidView/Pro RP FeaturesSolidView/Pro RP FeaturesSolidView/Pro RP Features

❋❋❋❋❋ CAD Interfaces: Provides the ability to directly read Pro/E*, CATIA, and Unigraphics* CAD files
❋❋❋❋❋ IGES/VDA Import:  Provides the ability to import IGES surface and solid data for viewing and

measuring
❋❋❋❋❋ Network Licensing: Allows multiple PCs to access SolidView licenses
❋❋❋❋❋ Bridgeworks: Provides for the automatic generation and slicing of stereolithography support structures

SolidView/Pro RP OptionsSolidView/Pro RP OptionsSolidView/Pro RP OptionsSolidView/Pro RP OptionsSolidView/Pro RP Options

Automatic and manual layout
functions let you maximize RP

system throughput

*Requires appropriate CAD system license
SolidView is a registered trademark of Solid Concepts Inc.
Other products are trademarks or registered trademarks of their respective holders.
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√ Integrated 2D and 3D View and Markup

√ View Data from All Popular CAD Systems

√ FREE SolidView/Lite Software--
Share Designs with Anyone
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Getting Started with SolidView
SolidView is a powerful, yet easy to learn Windows application designed to
communicate 3D and 2D design information.  Typically, this information was
created on a Computer Aided Design (CAD) system, but you do not need to be
familiar with a CAD system in order to use SolidView.  In fact, SolidView is
designed to be used by anyone who normally uses 2D drawings.  And since
SolidView is an interactive 3D application, most people find it easier to use
than 2D drawings.  This booklet will briefly describe the basic features of
SolidView 3.0.  For a complete description of SolidView capabilities, see the
Svdemo.sfx file in the SolidView installation directory or the complete on-line
help system.

Viewing 3D Data
SolidView has three primary functions, View, Measure, and Communicate.
The most basic function of SolidView is viewing 3D designs.  The first step in
using SolidView is to load a 3D file.  SolidView can read a variety of 3D file
formats such as STL and VRML files, and options are available to read other
formats such as IGES.  Select the Open menu item in the File menu to load an
STL file.  STL files consist of a series of facets or triangles that represent an
object or shape, typically a mechanical design generated on a CAD system.

An STL file called arm1.stl is included in the SolidView installation directory
and it’s a good file with which to get started.
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SolidView’s simple view buttons make it
easy to move the model in the direction
indicated by the arrows.  The curved but-
tons rotate the model, while the flat but-
tons move and zoom the model.  Simply
click with the left mouse button to change
the view as required.  Using the right
mouse button performs the same function,
but in bigger steps.  Go ahead and see
how each button changes the view.

SolidView supports a number of “stan-
dard” views, which can be selected by using the View drop down list in the
view control dialog.

SolidView also supports a number of display or rendering modes.  Since
SolidView performs very well on standard PC hardware, it is usually best to
view models in the default Shaded mode.  The other modes can be selected
using the Rndr  drop down list in the view control dialog.

To learn about the functions of the other buttons in the view control panel,
simply click on the Win  button and hit the F1 function key to activate
SolidView’s on-line help.

You can also rotate an object by holding down the right mouse button and
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moving the mouse over the view area.  With practice, you will find that this is
a very easy way to position an object.  If SolidView detects that it is taking too
long to generate the image when you rotate it this way, it will display and move
an outline that represents the object until you stop moving the mouse.  This
way you can still interactively position the object, even if you are using a slow
computer, or working with a very complex object.

Viewing 2D Data
SolidView also lets you view and markup 2D raster and vector images.  This
feature is designed to enable detailed engineering information, usually only
found on 2D drawings, to be displayed alongside SolidView’s 3D images.  A
2D image or graphic can be added to any SolidView slide by simply clicking

on the Add Graphic  tool button.  This will bring up a file open dialog
where the proper 2D graphic can be selected.  A 2D graphic window can be
activated by selecting the 2D graphic.

Once activated, the 2D toolbar  will be displayed in the 2D graphic window.
The function of each tool button can be displayed by moving the pointer over
each button without clicking on the button.  You can also view a 2D image by
using SolidView’s File | Open menu.

Managing 2D Images
Once a 2D image has been added, the image size can be changed by simply
clicking on the corner or side of the image as you can do with any standard
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Window.  As with the 3D display in SolidView, you can also pan the image by
holding down the Alt  key while pressing the right mouse button.

The Windows menu item makes it possible to cascade and tile the 2D images,
as well as hide and show the images.  It is important to note that each time a 2D
image is added to SolidView, only one copy of that file is loaded and saved in

the SolidView file, even if you use
the 2D Graphic button to load the
same image multiple times.  Depend-
ing on your communication intent,
you may want to have only one 2D
image on each SolidView slide, or
you may want to have multiple mini-
mized images on one slide—
SolidView gives you the complete
flexibility to choose.

A 2D CGM (Computer Graphics
Metafile) file called Arm1.cgm is
included in the SolidView installa-

tion directory.  Click on the Add Graphic tool button and select this file.  Using
the 2D tool buttons, you can create a view that displays the 3D object, a 2D
GD&T callout, and the full 2D drawing.
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2D Image Options
Double clicking on a 2D image will display the Markup Graphic Options dia-
log.  This dialog has two tabs, Options and Text.  The Options tab enables you
to set a variety of options that control the way 2D images are displayed.  Use
SolidView’s context sensitive help to display the functions of each option.
The Text tab can be used to set the font, font size, and color of the text of the
minimized 2D image.

Measuring with SolidView
The second primary function of SolidView is measuring a 3D design.  For this
example, we will use the Arm1.stl file that is included in the SolidView instal-
lation directory.  Please load this file if you have not already done so.

You have probably already noticed the SolidView toolbar along the top of the
SolidView window.  Each button in the toolbar performs a SolidView function

and eliminates the need to use
menu items for most SolidView
operations.  Simply use the

mouse to point to a button (but don’t click on it!) to see the name of the func-
tion to be performed.  The buttons can be used to measure various features of
a design.

Move the mouse over each one to familiarize yourself with their functions.
Click on the Measure Object button and SolidView will calculate everything
from the basic dimensions of the object to its volume and surface area.
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You will notice the information is displayed in the measure dialog as well as
on the model itself.

Clicking on the Done button in the dialog will clear the information.  If you
want to clear the dimensions from the model, use the Erase Annotations button

or Erase ALL Annotations button, as shown here:    You can also use

the Del key to erase the selected annotation.

Once you have erased the annota-
tions, use the View menu in the view
dialog to select the IsoMetric  view
of the Arm1 model.  Then click on
the Measure Arc button.

Next use the mouse to select the hole
on the top of the object.  SolidView
will then calculate the diameter and
other features of the arc and display
the information in the dialog on the
right.  SolidView also creates a diam-
eter dimension on the model.  If you

want to change the attributes of the dimension, such as the text size, simply
double-click on the dimension.  Using the other measurement buttons, you can



9

measure distances between faces, edges, and vertices, as well as angles and
other design features.

With SolidView, you can define a section for viewing, measuring, and export-
ing to a 2D DXF file.  To define a section, use the Measure | Define Section

menu item, or click on the Define
Section tool button.

The Define Section dialog is used
to identify the section plane and po-
sition, as well as how the section is
displayed.  To position the section
plane, use the slider or click on the
object.  The C button will center the
section plane on the object and the
A button will animate the section
through the object or objects.  Once
the section has been properly posi-
tioned, click on the Done button to

complete the operation.  Once the section has been defined, you can use any of
SolidView’s measurement tools to measure features of the section.  Multiple
objects can be sectioned at one time by using the Select menu item to select
the objects prior to defining the section.

In addition to creating measurement dimensions, SolidView also lets you add
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text, notes, boxes, arrows, and red-line markups using the following buttons:

Collectively, these are called annotations, and
in the next section you will see how they can be

used with SolidView’s record and playback capability to facilitate true design
communication.

Design Communication with SolidView
With SolidView it’s easy to add markups, such as arrows, circles, text, and
notes to a 3D view or 2D image.  These markups can be used to highlight
errors, suggest changes, or to call attention to particular design features.  Any
markup can be added to a 2D image, with the exception of another 2D image.
Markups must begin and end inside a 2D image—they cannot extend outside
of the image.

One of SolidView’s most powerful features is its ability to record and play-
back multiple views or “slides”.  Each slide can have its own set of measure-
ments or annotations, as well as its own views of the model.  This makes it
possible to create an “electronic” design review for effective design communi-
cation.

To create a simple slide show with SolidView, first add a few annotations to

the model and then select the Save Slide button:  
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This will bring up the save slide dialog where you can rename the slide, add a
description, and set a display time.  After you have saved the first slide, use the
Erase ALL Annotations button or the Del key to clear the annotations that will
not be in the next slide.  You can then add any new annotations or 2D images,
change the view, or create a section view before you save another slide.

Once you have saved all the slides, you can replay them using the slide play-

back buttons:  

Managing Annotations
SolidView makes it easy for multiple people to review and comment on a
design.  A feature called authoring keeps track of who adds annotations to an
SFX file and when they were added.  Navigation tools enable users to review
existing annotations based on author.  To use this feature you must select the
Annotate | Authoring Mode menu item.  Once authoring has been enabled,
you must register as an author before you create any annotations.  Select the
Annotate | Author Registration menu item to display the Author Registra-
tion dialog.  If desired, you can add a password to prevent others from chang-
ing your annotations, and you can select a color scheme to make your annota-
tions easy to identify.  In order to properly review authored annotations, you
must save at least one slide, using the SolidView Save Slide button .  If authoring
is enabled, but no author is registered, any attempt to create an annotation will
result in the Author Registration dialog being displayed.
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To review annotations, select the Annotate | Author Navigation menu item
to display the Author Navigation dialog.  The Author Navigation dialog has
options that enable you to set the way in which annotations are displayed.
Once author navigation is enabled, use the slide playback buttons

 to review the annotations.

Please note that if author navigation is enabled, but no authors are selected to
be shown, no annotations will be displayed.

Saving Annotations and Slides
The STL file format that SolidView uses does not support things like slides
and annotations.  In order to save these features with your model, you must
save the file in SolidView’s SFX format.  In addition to saving all the annota-
tion and slide information, SFX files have the additional benefit of being much
smaller than standard STL files.

This would be a good time to go ahead and save your file by using the Save
SFX function in the File menu.  Once you have saved an SFX file, this file can
be sent to anyone who needs to view the slides and annotations you have cre-
ated.  You might think that they would need a copy of SolidView in order to
read the SFX file, but that is not the case.  In order to provide effective design
communication, SolidView can “publish” an SFX file, complete with a copy
of SolidView/Lite, which allows the recipient to view the slides and annota-
tions you have created.
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In fact, SolidView/Lite includes most of the viewing and measuring capabili-
ties of SolidView, but it only operates on SFX files.  You can freely distribute
copies of SolidView/Lite, subject to the SolidView/Lite license agreement.

Publishing SFX Files
To publish an SFX file, complete with a copy of SolidView/Lite, simply select
the Publish function from the File menu.  SolidView will prompt you for a file
name, and then display the publish dialog.

Published files are always executable files (of type EXE) because they are
actually multiple files saved as a self-extracting program.  Within the publish
dialog, you can set a password or include SolidView/Lite.  The password is
useful if you are sending the published file over the Internet as the file cannot
be extracted without the password.

If you publish the file to floppy disks, SolidView automatically takes care of
the multiple disks, but you need to make sure the disks are formatted before
you start.

Once you have published a file, it can be sent to anyone with a Windows 

file.
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Printing with SolidView
SolidView is designed to work with both color and monochrome Windows
printers.  Select the File | Preferences menu item and then select the Printing
tab to set the printing options.  Press the F1 function key to display on-line
help for the SolidView printing options.

Creating VRML and HTLM data
You can save your SolidView files in VRML and HTML formats for viewing
with standard web browsers.  Use the File | Save SFX menu item and select a
file type of HTLM, VRML 1.0, or VRML 2.0.

Interactive Viewing Controls
Arc Ball Right Mouse
Axis Arc Ball Right Mouse + Ctrl Key
Zoom Window Left Mouse + Alt Key
Drag Zoom Left Mouse + Ctrl Key + Alt Key

Right Mouse + Ctrl Key + Alt Key
Drag View Right Mouse + Alt Key
Move Light Right Mouse + Shift Key
2D/3D Pan Middle Mouse
Zoom Intellimouse wheel

Supported 3D File Formats
DXF 3D face data in DXF format
IGS IGES data (Optional)
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OBJ Object file
SFX SolidView
SLDPRT SolidWorks part file
SLDASM SolidWorks assembly file
STL Stereolithography
SV SolidView 1.0 format
VDA German standard for transfer of surface data (Optional)
WRL VRML (1.0
Plugins for direct support of native CAD data are available from your
Authorized SolidView reseller.  See

Supported 2D File Formats
BMP OS/2 or Windows bitmap
CGM Computer Graphics metafile
DXF Autodesk Drafting Interchange
DWG Autocad drawing
EMF Enhanced Windows metafile
GIF CompuServe
HPGL HP Graphics Language
HPGL2 HP Graphics Language
JPEG JPEG group
PCT Macintosh PICT
PCX ZSoft Paintbrush
continued...
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Supported 2D File Formats (continued)
PNG Portable Network Graphics
RAS Sun Microsystems
TARGA Truevision
TIFF Tagged Image File Format
TXT Text document
WMF Windows metafile

OpenGL Graphics
Starting with release 3.2, SolidView provides the option of using OpenGL
graphics instead of SolidView’s internal rendering algorithms.  OpenGL
graphics are supported under Windows 95
OpenGL graphics are not supported under Windows 3.1.  The advan-
tages of OpenGL are:

* More colors * Transparency
* High quality graphics * Spectral highlights (shininess)
* Support for OpenGL accelerated hardware

The primary disadvantage of OpenGL is that it requires more resources, and
will result in longer drawing times, unless you have special OpenGL
hardware.  The good news is that SolidView makes it easy to switch in and
out of OpenGL mode, so you have complete flexibility.  Any files you create
in SolidView while running in OpenGL mode are fully compatible with
SolidView’s internal rendering algorithms, but you won’t be able to see any
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additional colors or transparent objects.

Enabling OpenGL Graphics
You can enable OpenGL graphics selecting “OpenGL mode” from the
Display | Render menu.  OpenGL graphics can be disabled by selecting
“Software mode” from the Display | Render menu.  Please note that your
display must be set to 16 bit (high color or 32K colors) in order to enable
OpenGL graphics.  OpenGL graphics can also be enabled from the Render-
ing tab in the File | Preferences dialog and the Color tab in the Select |
Object Attributes dialog.

Hardware Acceleration
If you have a graphics board that supports OpenGL accelerated graphics,
you can enable this by selecting the Hardware Acceleration option under the
Rendering tab in the File | Preferences dialog.  By default, hardware
acceleration is disabled in SolidView as the latest video drivers may be
required in order for a particular graphics board to operate correctly.  If you
encounter problems while using hardware acceleration, you should contact
your video board supplier and verify that you have the latest video drivers
installed.

SolidView DDE Interface
Starting with release 3.2,  SolidView supports dynamic data exchange
(DDE).  DDE is an established protocol for exchanging data between
Windows-based applications.  Using DDE, other Windows applications,



such as Microsoft Access, can send information and commands to SolidView.
For example, it is possible for Microsoft Access to issue DDE commands to
open a particular file in SolidView, and then print that file. The following
DDE commands are available in SolidView:

Command                   Function
Open(filename)           Opens a file
Print()                          Prints the current file
Activate(mode #)        Activates the SolidView window
Exit()                           Exits SolidView

For more information on SolidView’s DDE commands, see the DDE topic in
SolidView’s online help, or the Access or DDE directory in the Samples
folder on the SolidView CD-ROM.

Learning More About SolidView
In addition to the features described in this booklet, SolidView has many
more features designed to make it easier to communicate design informa-
tion.  SolidView’s complete on-line help provides reference information for
all SolidView functions.  If you need additional help, or if you have any
questions regarding SolidView, you should contact your SolidView reseller,
C2C Technologies, Inc., via e-mail at help@cadcommunications.com.  You
can contact us via the World Wide Web, phone, or fax, as shown on the back
of this booklet.

Installing SolidView
The SolidView CD-ROM contains SolidView software, demonstration files,
and sample data files.  To install SolidView software, run or install the

18
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demonstration files, or browse the contents of this CD-ROM, following
these instructions:
1. Insert the CD-ROM into the CD-ROM drive.
2. From the Start menu, select Run.
3. In the Open field, enter x:\setup, where x is the letter of your CD-ROM

drive.
4. Select OK.

At the end of the installation procedure, you will be prompted for an installa-
tion password.  You must contact your authorized SolidView Reseller, 

SolidView Network Installation
SolidView can be installed on a network under a number of concurrent users
license.  SolidView can only be installed on a network if you have purchased
a SolidView network license.  A SolidView network license allows a
specific number of SolidView clients to access a copy of SolidView installed
on a server.  The networked version of SolidView will run on any network
which supports the following:

SolidView Program Directory
A Network Directory mountable with a drive letter by a Windows
Client for at least read access.  (A Windows client is any Intel or
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compatible based system running Windows 95
Windows NT 3.51 or NT 4.0)  This directory will contain the
installed SolidView executable program.

SolidView NetLicense Directory
A Network Directory shared for read/write with a UNC name
(Universal Naming Convention).  This directory will contain the
network license file.  All clients MUST be able to read/write the
file.

The Microsoft Windows network meets these requirements.

Server Installation
The server may be a Windows NT Server 3.51 system, any Windows NT
Workstation 3.51 or 4.0 computer, any Windows 95
any other FILE SERVER supporting the conditions above.  The network in-
stallation will use the following directories:

SolidView Program Directory:
 C:\SLDVIEW to be shared as \\<SERVER>\SLDVIEW
 This directory must be mapped by the clients with a drive letter
 such as S:

SolidView NetLicense Directory:
C:\SLDVIEW\SVIEWNET to be shared as \\<SERVER>\SVIEWNET
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This directory is not mapped by the clients.

1 Install SolidView on the Server as described under Installing Single
User on Windows 95
NT 4.0.  You will not be prompted for any of the network parameters
until after you have entered your SolidView program key.

2 You must contact your Authorized SolidView Reseller

3 Select the network installation type.
After entering the SolidView program key, you will be given the choice
of selecting a network drive or Windows file sharing installation.

4 Specify the NetLicense Directory on the Server.
SolidView will prompt you for a network directory such as
c:\sldview\sviewnet.  This directory will be used to track network
licenses and must be shared with read/write access for all clients.
Using a subdirectory is recommended since it protects application files.

5 Specify the UNC name to the NetLicense Directory.  SolidView will
then prompt you for the UNC network path for the NetLicense directory
created above.  The network path must follow the UNC (Universal
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Naming Convention) format which consists of two back slashes ‘\\’
followed by the server name, followed by another back slash ‘\’ and the
network share name such as \\<SERVER>\directory. SolidView clients
will use this network path to access the license file ‘sldview.net’.

6 Exit SolidView.

7 Configure your server to share the SolidView install directory
(c:\sldview) with read access for all clients.

8 Configure your server to share the SolidView network directory
(c:\sldview\sviewnet) with read/write access.

Network Client Installation
1 Connect to the server and network drive where SolidView was installed

using the Network Neighborhood icon or the File Manager.  (The share
name \\<SERVER> \SLDVIEW should be what you want.  Check with
your Network System Administrator, if needed.)  Since you will need
access to this same network drive with the same drive letter, it is
highly recommended that you specify that the connection is re-
established next time you login.

2 Run SolidView.
Using the File Manager or Explorer, open the drive mounted above and
double click on ‘sldview.exe’ or use the Program Manager’s run
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command and specify <s>:\sldview.exe where <s> is the drive letter you
specified when mounting the SolidView Program Directory above.

3 SolidView will prompt you to determine if you want to perform
Network Setup (this allows each Client to have its own SolidView
defaults).  Select OK to continue with the Client Network Setup.

4 SolidView will then prompt you for a local directory to install defaults
and other information (< 200K required). This directory will be used to
save the user’s default settings in a file called ‘sldview.df’.

5 SolidView will then prompt you for a Program Group Name.  Several
icons and start menu options will be created for accessing SolidView and
SolidView Help.

Note: The Program Manager group icons will be created using the current
SolidView network drive. If you disconnect the network drive or connect the
drive to a different drive letter the icons will no longer be valid. If the network
drive changes often in your network environment then simply skip the Create
Program Group setup by selecting Cancel. You can run Network Setup at any
time to change settings by selecting Network Setup for the SolidView File
menu.



About Solid Concepts  &  C2C Technologies, Inc.
Solid Concepts Inc. is the world’s leading supplier of third-party software for
the rapid prototyping industry and is a recognized leader in rapid prototyping
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